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Предисловие 
 
В этой книге описана работа с приложением ArchiCAD 11 — общепризнан-
ным лидером программных средств для проектирования зданий. Книга со-
держит материал, достаточный для овладения базовыми инструментами про-
граммы на уровне, который позволит начинающему пользователю 
немедленно приступить к работе в фирме, занятой коммерческими проектами 
в области строительства. Для чтения книги не требуется какой-либо предва-
рительной подготовки, изложение рассчитано на начинающего проектиров-
щика зданий и с особым упором на закрепление у читателя практических на-
выков работы с программой.  

Особым достоинством книги можно назвать опору на визуальное представле-
ние информации. Вместо длинных и скучных пояснений мы предлагаем чи-
тателю серии практических пошаговых процедур, реализующих конкретные 
операции по построению чертежа здания — от фундамента до крыши. Каж-
дый шаг в этих процедурах проиллюстрирован рисунком, который наглядно 
показывает результат его исполнения, а также снабжен различными указате-
лями на элементы интерфейса программы, используемые при работе с про-
граммой. У читателя нет нужды вчитываться в строки текста и искать на эк-
ране компьютера те кнопки, переключатели и флажки, которые нужно 
нажимать и устанавливать, чтобы добиться нужного результата — скажем, 
настроить высоту стены или выбрать ее материал — нужно просто следовать 
за видеорядом на одной стороне страницы, используя текст лишь как ком-
ментарии к описываемой процедуре.  

Как показывает опыт, используя такую продвинутую и современную методи-
ку, читатель быстро и легко осваивает самые запутанные технические прие-
мы работы с программой, не тратя время на перемалывание никчемной (по 
большей части) теории, имеющей самое отдаленное значение для специали-
ста-практика. Лозунг книги вполне в духе времени: не нужно объяснять — 
почему, скажите — как! Как сделать чертеж дома, состоящего из фундамента, 
стен, межэтажных перекрытий, крыши, окон, дверей, лестниц? Как оформить 
чертеж, указать размеры, заполнить штампы, ввести нужные надписи, как, 
наконец, просмотреть финальный результат в трехмерном виде и напечатать 
его, чтобы подготовить рабочие чертежи? Обо всем этом рассказано в данной 



Предисловие 

 

2 

книге, прочитав которую вы станете профессиональным пользователем Ar-
chiCAD. 

В первых главах книги описан интерфейс программы, дано введение в техни-
ку построения геометрических фигур — линий, прямоугольников, окружно-
стей, которые реализуют объекты строящегося чертежа. Вы узнаете, что та-
кое характеристическая точка, интеллектуальный указатель, направляющие, 
электронная рейсшина и объектная привязка, как с их помощью создаются 
объекты с точными параметрами, как эти объекты редактируются и исполь-
зуются при работе над проектом. 

Далее описано построение конструкционных элементов здания — фундамен-
тов, стен, перекрытий, балок, колонн, крыш. В процессе изложения материала 
мы шаг за шагом построим двухэтажное здание, которое прекрасно иллюст-
рирует все этапы проектирования в реальном коммерческом проекте, напри-
мер небольшой дачи. Далее мы описываем, как, используя библиотеку стан-
дартных объектов, можно установить в доме окна, двери, лестницы, 
светильники, т. е. спроектировать домашний интерьер, решив важнейшую 
задачу дизайна внутренних помещений. Последнее является исключительным 
достоинством книги — вы научитесь совмещать проектирование здания с 
дизайном интерьеров, достигая при этом наиболее эффективных результатов.  

В оставшейся части книги описаны технические подробности, касающиеся 
просмотра и печати своих результатов как в двумерном, так и трехмерном 
виде. Вы научитесь строить деталировочные и внешние чертежи, создавать 
объемные разрезы и различные типы проекций, устанавливать параметры 
трехмерной визуализации и накладывать текстуры на элементы конструкции. 
На финишном этапе описывается техника образмеривания чертежа и вывод 
результата на принтер или плоттер — и все, чертеж готов, теперь можно при-
ступать к строительству здания! 

Ко всем прочим достоинствам книги добавляется наличие диска с видеокур-
сом, который содержит динамичные видеолекции по работе с программой. 
Они дополняют материал книги, а также помогут вам овладеть работой с про-
граммой, так сказать, "вживую", наблюдая, как лектор шаг за шагом строит 
на экране компьютера настоящее здание. Вы сами убедитесь, насколько 
эффективно и быстро вы овладеете основами работы с программой, 
просмотрев за чашкой чая эти лекции, чтобы потом углубить и расширить 
знания и умения чтением книги. 

Прочитав книгу, вы освоите ArchiCAD 11 до уровня настоящего профессио-
нала, который в состоянии спроектировать дом от начала и до конца, не при-
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бегая к посторонней помощи, станете специалистом, подготовленным для 
работы в любой проектной организации — и все это без особых усилий и по-
тери времени, благодаря уникальному методу изложения материала и пре-
красным примерам, иллюстрирующим технику работы с программой. 

От автора 
Мне будет интересно узнать ваше мнение об этой книге и выслушать замечания, 
предложения и советы по ее содержанию и стилю изложения, а также о видео-
курсе, который находится на диске, приложенном к книге. Пишите мне по адре-
су AlexanderZhadaev@sigmaplus.mcdir.ru с пометкой "читатель" в поле "Тема". 
Также предлагаю посетить свой сайт http://www.alexanderzhadaev.mcdir.ru, на 
котором я предполагаю размещать дополнительные материалы по книге. 

 

Александр Жадаев 

 



 

 
ГЛАВА 1 

Быстрый старт 
В этой книге речь пойдет о самой популярной системе автоматизированной 
разработки архитектурно-строительных проектов — ArchiCAD. Главное дос-
тоинство этой системы состоит в том, что при работе в ней разработчик не 
чертит чертежи, а создает трехмерную виртуальную модель проекта, что дает 
возможность: 
� максимально наглядно представить проект; 
� уменьшить время разработки за счет использования готовых блоков: две-

рей, окон, оборудования систем обеспечения жизнедеятельности и т. д.; 
� автоматически получить необходимые плоские и трехмерные виды для 

оформления проектной документации, включая планы, разрезы, фасады 
и т. п.; 

� автоматически рассчитать смету проекта; 
� и многое другое… 
В данном издании рассматривается последняя на момент выпуска книги вер-
сия ArchiCAD — 11. 

1.1. Установка 
Установка ArchiCAD не требует особых знаний. Предположим, что у вас 
имеется компакт-диск с установочными файлами ArchiCAD, и вы поместили 
его в устройство чтения компакт-дисков. Выполните следующие действия. 
1. Двойным щелчком кнопкой мыши 

на файле setup.exe, расположенном 
в корневой папке диска, запустите 
его на выполнение. На экране по-
явится диалоговое окно мастера 
установки, который осуществляет 
подготовку системы к установке.  
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ПРИМЕЧАНИЕ  
Если при установке компакт-диска в привод произошел автозапуск про-
граммы установки, выберите из появившегося меню команду Install Archi-
CAD (Установить ArchiCAD). 

2. Дождитесь появления следую-
щего диалогового окна. Оно 
предупреждает о том, что перед 
началом установки необходимо 
завершить все работающие про-
граммы. Выполните это требо-
вание и щелкните на кнопке 
Next (Далее). 

 

 

3. На экране появится диалоговое 
окно выбора варианта установ-
ки. Если у вас лицензионная 
версия, то оставьте переключа-
тель в положении ArchiCAD 11 
Commercial license (Коммерче-
ская лицензия) и щелкните на 
кнопке Next (Далее). 
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ПРИМЕЧАНИЕ  
Если устанавливается нелицензионная версия, то выберите положение Ar-
chiCAD 11 Trial license (Ознакомительная лицензия). После регистрации 
на сайте производителя вы получите код для запуска программы в режиме 
ознакомления. 

4. В открывшемся диалоговом 
окне вы можете ознакомиться с 
лицензионным соглашением, 
после чего установите распо-
ложенный внизу переключа-
тель в положение I accept (Со-
гласен) и щелкните на кнопке 
Next (Далее). 

 

 

ПРИМЕЧАНИЕ  
На любом шаге процесса установки для изменения уже введенных парамет-
ров можно вернуться в предыдущее окно щелчком на кнопке Back (Назад). 

5. В поле открывшегося окна ото-
бражен путь к папке, в которую 
будет установлен ArchiCAD. 
Если вас устраивает это место 
установки, щелкните на кнопке 
Next (Далее). 
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ПРИМЕЧАНИЕ  
При необходимости изменения стан-
дартной папки установки щелкните 
на кнопке Browse (Просмотр) и вы-
берите другую папку. 
 
6. В очередном диалоговом окне 

выбирается тип установки. Ос-
тавьте переключатель в поло-
жении Typical (Стандартная) и 
щелкните на кнопке Next (Да-
лее). 

 

 

7. В поле открывшегося окна ука-
зана папка, в которую будут 
помещены ярлыки запуска Ar-
chiCAD. Не изменяя информа-
ции, щелкните на кнопке Next 
(Далее). 

 

 

8. Очередное окно предупреждает 
о необходимости удаления 
ключа аппаратной защиты пе-
ред установкой программы. Ес-
ли вы уже вставили ключ, то 
удалите его и щелкните на 
кнопке Next (Далее).  
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9. Последнее окно настройки па-
раметров установки выводит 
общую информацию. Для на-
чала установки щелкните на 
кнопке Install (Установить). 

 

 
10. В течение некоторого времени 

будут выполняться действия 
по установке программы, со-
провождаемые сменой иллю-
страций и текущим состояни-
ем процесса установки на 
расположенном внизу индика-
торе. Дождитесь появления 
следующего окна.  

11. В появившемся окне устано-
вите необходимые флажки 
(сверху вниз): 

• для создания значка про-
граммы на рабочем столе; 

• для помещения значка 
программы в панель быст-
рого запуска; 

• для автоматического от-
слеживания обновлений.  

Щелкните на кнопке Next 
(Далее). 
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ПРИМЕЧАНИЕ  
Поиск и загрузка обновлений программы возможны лишь при наличии ак-
тивного соединения с сетью Интернет. 

12. Процесс установки завершен. 
Перед первым запуском про-
граммы необходимо переза-
грузить компьютер, для чего 
установите переключатель в 
положение Yes, restart my 
computer (Да, перезагрузить 
компьютер) и щелкните на 
кнопке Next (Далее). 

 

 

ВАЖНО  
Если вы установили коммерческую версию, перед перезагрузкой установи-
те ключ аппаратной защиты в соответствующий разъем компьютера. 

1.2. Запуск 
После перезагрузки компьютера система ArchiCAD готова к работе. Для за-
пуска программы выполните следующие действия. 

1. Дважды щелкните на значке , 
расположенном на рабочем столе. 
На экране откроется окно запуска 
ArchiCAD. 
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ПРИМЕЧАНИЕ  
Запуск ArchiCAD можно также выполнить 
из панели быстрого запуска или выполнив 
команду главного меню Windows Пуск►
Все программы►Graphisoft►ArchiCAD 11►
ArchiCAD 11 (Start►All programs►Graphisoft►
ArchiCAD 11►ArchiCAD 11). 

 
 
2. Дождитесь появления стартового окна 

ArchiCAD и щелкните на кнопке New 
(Создать). 

  

 
3. Через некоторое время откроется окно рабочей среды программы ArchiCAD. 
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1.3. Сохранение  
и открытие проекта 
Как и во всех подобных программах, по завершении работы текущее состоя-
ние разрабатываемого проекта сохраняется в виде файла. При очередном за-
пуске программы сохраненный проект загружается для продолжения работы. 
 

1. Для сохранения проекта выпол-
ните команду главного меню 
ArchiCAD File►Save (Файл►Со-
хранить). 

  

2. В появившемся окне в раскры-
вающемся списке Папка укажите 
папку, в которой будет храниться 
проект, введите в поле Имя фай-
ла название сохраняемого проек-
та и щелкните на кнопке Сохра-
нить.  
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ПРИМЕЧАНИЕ  
Запрос места сохранения и имени файла проекта выдается при первом со-
хранении. В дальнейшем при выполнении команды File►Save (Файл►Со-
хранить) дополнительных запросов выдаваться не будет. При необходимо-
сти сохранить проект под другим именем используйте команду File►Save 
as (Файл►Сохранить как). 

3. При очередном запуске Archi-
CAD в стартовом окне будет ото-
бражен список сохраненных 
проектов, поэтому для открытия 
необходимого проекта нужно 
выделить его и щелкнуть на 
кнопке Open (Открыть).  

 

4. Для открытия проекта из рабочей среды Ar-
chiCAD выполните команду главного меню 
ArchiCAD File►Open (Файл►Открыть). 
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5. Выберите необходимый файл 
проекта (файлы проектов Archi-
CAD имеют расширения pln, pla 
или bpn) и щелкните на кнопке 
Открыть. 

 

 

ПРИМЕЧАНИЕ  
ArchiCAD позволяет открыть и другие типы файлов. Для этого необходимо вы-
брать нужный тип из раскрывающегося списка Тип файлов, затем указать не-
обходимый файл в отобразившемся списке и щелкнуть на кнопке Открыть. 

6. Если в среде ArchiCAD уже от-
крыт проект и в него вносились 
изменения, то будет выведено со-
общение Save changes to the Pro-
ject "ProjectName" before 
closing? (Сохранить изменения в 
проекте "Имя проекта" перед за-
крытием?). 

 

ПРИМЕЧАНИЕ  
Это сообщение выводится потому, что ArchiCAD не позволяет открыть од-
новременно несколько файлов проектов, поэтому текущий проект необхо-
димо закрыть. Щелкните на одной из кнопок Don't save (Не сохранять), 
Cancel (Отменить) или Save (Сохранить). 

СОВЕТ  
Для работы с несколькими проектами необходимо запустить такое же коли-
чество копий ArchiCAD. Для этого при открытии файла нужно установить 
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флажок Launch a new instance of ArchiCAD (Запустить копию ArchiCAD) в 
окне, показанном в п. 5. В этом случае новый проект откроется в отдельном 
окне и появится возможность не только одновременной работы с несколь-
кими проектами, но и обмена данными между ними. В частности, можно ко-
пировать или перемещать объекты из одного проекта в другой через буфер 
обмена или перетаскиванием мышью. 

1.4. Рабочая среда ArchiCAD 
ArchiCAD предоставляет разработчику удобную среду, обеспечивающую 
простую и эффективную работу. Рабочая среда ArchiCAD состоит из сле-
дующих областей. 

Рабочая область, предназначенная 
для создания, редактирования и ото-
бражения видов проекта. Располо-
жена в центральной части окна про-
граммы. 

 

Строка главного меню. Расположена 
в верхней части окна программы. 
Содержит сгруппированные по раз-
делам команды ArchiCAD. Выбор 
пункта меню открывает команды 
соответствующего раздела. 
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Панель инструментов, в которой расположены кнопки вызова наиболее часто 
востребованных команд ArchiCAD. Находится под строкой главного меню. 

 

Палитра инструментов, содержащая инструменты 
создания и выбора объектов ArchiCAD и предна-
значенная для их быстрого вызова. Расположена у 
левой границы окна программы. 

  
Информационная палитра. Расположена над рабочей областью. При выборе 
одного из инструментов в этой палитре появляются элементы настройки его 
параметров. Поэтому вид этой палитры зависит от активного в данный мо-
мент времени инструмента. 
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Палитра навигации. Расположена у правой гра-
ницы окна программы. Предназначена для хра-
нения и отображения информации о проекте, а 
также работы с ней. 

  

1.5. Настройка интерфейса 
ArchiCAD позволяет изменить вид рабочей среды, включая расположение, 
состав и структуру меню, панелей и палитр, для организации максимально 
комфортной работы пользователя. 
1. Положение панелей и палитр можно изменять, например, для облегчения 

доступа к расположенным в них элементам управления. Сделайте двойной 
щелчок на заголовке информационной палитры. Палитра изменит свое по-
ложение. 
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2. Установите указатель мыши на нижнюю границу информационной палит-
ры и, нажав левую кнопку мыши, потяните вниз. После отпускания кнопки 
мыши все инструменты палитры станут доступными. 

 

ПРИМЕЧАНИЕ  
Размеры палитр можно изменять, не перемещая их со стандартного места 
расположения. 

3. Установите указатель мыши на заголовок палитры, нажмите левую кнопку 
мыши и перетащите палитру к правой границе палитры инструментов. По-
сле отпускания кнопки информационная палитра расположится вплотную 
к палитре инструментов. 
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ПРИМЕЧАНИЕ  
Возможность каскадной привязки свойственна большинству палитр. Панели 
инструментов могут быть привязаны только к границам экрана. 

4. Для включения/отключения па-
нели инструментов выполните 
команду главного меню 
Window►Toolbars (Окно►Па-
нели) и щелкните на необходи-
мой панели списка. Включенная 
панель появится на экране, а в 
списке панелей пометится 
флажком. 

 

5. Для включения/отключения па-
литры инструментов выполните 
команду главного меню 
Window►Palettes (Окно►Па-
литры) и щелкните на необхо-
димой палитре списка. Вклю-
ченная палитра появится на 
экране, а фон ее значка в списке 
палитр будет закрашен. 
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6. Для изменения состава и струк-
туры меню, панелей и палитр 
предназначено диалоговое окно, 
вызываемое командой главного 
меню Options►Work Environ-
ment►Work Environment (Па-
раметры►Рабочая среда►Рабо-
чая среда). 

 

7. Совокупность всех установлен-
ных настроек интерфейса назы-
вается профилем. Профиль раз-
деляется на группы настроек — 
схемы: 

• User Preference Schemes 
(Основные установки); 

• Company Standards Schemes 
(Корпоративные стандарты); 

• Shortcut Schemes (Горячие 
клавиши); 

• Tool Schemes (Инструменты); 

• Palette Schemes (Палитры); 

• Command Layout Schemes 
(Структура меню). 
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8. Схема состоит из областей 
настройки конкретных па-
раметров. Например, в об-
ласти Selection and 
Element Information (Па-
раметры выбора и инфор-
мация об элементе) на-
страивается вид выделяе-
мого и выделенного 
объектов и окна с инфор-
мацией о нем. 

 

ПРИМЕЧАНИЕ  
Под объектом здесь понимается графический элемент, находящийся в ра-
бочей области программы. 

9. После настройки всех параметров 
схему можно сохранить. Для это-
го нужно выделить схему щелч-
ком на ее заголовке, щелкнуть на 
кнопке Store as… (Сохранить 
как) и ввести название схемы в 
поле Scheme name (Название 
схемы) появившегося окна. 
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10. После щелчка на кнопке Store (Сохранить) название схемы появится в 
списке вариантов схем. Для активизации схемы необходимо выделить ее 
и щелкнуть на кнопке Apply Scheme (Применить схему). 

 

 

ПРИМЕЧАНИЕ  
Если кнопка Apply Scheme (Применить схему) недоступна, это означает, 
что данная схема в настоящий момент уже является активной. 
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11. Схемы можно сохранять с целью обмена ими между проектами. Для со-
хранения схемы необходимо выделить ее, щелкнуть на кнопке Export…  
(Экспортировать) и указать место сохранения схемы в появившемся окне, 
используя кнопку Browse… (Обзор). После последовательных щелчков 
на кнопках OK окна Обзор папок и Export… (Экспортировать) окна Ex-
port Scheme (Экспортировать схему) схема будет сохранена.  

 

ПРИМЕЧАНИЕ  
Схема сохраняется в файле ИмяСхемы.xml, где ИмяСхемы — название, 
под которым схема сохранена в списке схем. Для переноса схемы на дру-
гой компьютер достаточно перенести на него необходимый файл и загру-
зить схему. 
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12. Для загрузки схемы щелкните на кнопке Import…  (Импортировать) и 
укажите место расположения файла схемы, используя кнопку Browse… 
(Обзор). После щелчка на кнопке OK окна Обзор папок в списке окна 
Import Scheme (Импортировать схему) появятся имена схем. Осталось 
указать необходимую схему и щелкнуть на кнопке Import… (Импорти-
ровать). 

 

ПРИМЕЧАНИЕ  
Кнопки Rename… (Переименовать) и Delete (Удалить) области Scheme Op-
tions (Параметры схемы) предназначены для выполнения соответствую-
щих операций со схемами. Щелчок на кнопке Redefine (Переопределить) 
присваивает активные настройки помеченной в списке схеме.  
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13. Для создания нового профиля необходимо выделить заголовок профиля и 
щелкнуть на кнопке New Profile… (Создать профиль). В поле Enter the 
name of the Profile (Введите название профиля) появившегося диалогово-
го окна вводится название создаваемого профиля, а для каждой схемы 
профиля из списка схем выбирается необходимый вариант. 

 

ПРИМЕЧАНИЕ  
Экспорт и импорт профилей осуществляется так же, как и схем. Сохране-
ние схем и профилей дает возможность создавать для более эффективного 
выполнения конкретных работ различные схемы настроек интерфейса Ar-
chiCAD, а также обмениваться ими. 
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Заключение 
В этой главе вы совершили первые шаги по освоению системы автоматизиро-
ванного проектирования ArchiCAD: осуществили установку программы, оз-
накомились с основными элементами среды разработки и интерфейса про-
граммы, научились сохранять и открывать файлы разрабатываемого проекта. 
В следующей главе мы начнем рассматривать инструменты создания плоских 
геометрических примитивов, с помощью которых создается и оформляется 
проектная документация. 
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